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Typographic Conventions

Typographic Conventions

Type Style Description

Example Words or characters quoted from the screen. These include field names, screen titles,
pushbuttons labels, menu names, menu paths, and menu options.
Textual cross-references to other documents.

Example Emphasized words or expressions.

EXAMPLE Technical names of system objects. These include report names, program names,
transaction codes, table names, and key concepts of a programming language when they
are surrounded by body text, for example, SELECT and INCLUDE.

Example Output on the screen. This includes file and directory names and their paths, messages,
names of variables and parameters, source text, and names of installation, upgrade and
database tools.

Example Exact user entry. These are words or characters that you enter in the system exactly as they
appear in the documentation.

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters
with appropriate entries to make entries in the system.

EXAMPLE Keys on the keyboard, for example, F2  or ENTER .
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1 Introduction

To ensure business continuity and near-zero data loss in case of planned or unplanned downtime, we provide a
high availability solution for the SAP HANA® database server for the SAP Business One® 10.0, version for SAP
HANA® application. The high availability solution is made possible by the well-designed system replication
mechanism of SAP HANA.
In a highly available environment, you have a primary (active) system and a secondary (standby) system. The
secondary system is set up as an exact copy of the primary system and there is a continuous replication of all
persisted data to the secondary system.
You can configure high availability for automatic failover. In an automatic failover, the former primary system
switches to the secondary system automatically in the event of failure. An automatic failover includes both the
analysis and transaction functions of SAP Business One 10.0, version for SAP HANA.
An automatic failover is implemented through clustering of SAP HANA on SUSE® Linux Enterprise Server (SLES),
for SAP applications. With SUSE Linux Enterprise Server for SAP Applications, you can even build an OS-level
cluster and identify the SAP HANA database as a cluster resource.
This guide provides instructions on how to set up, upgrade and maintain a high availability environment for the
SAP HANA database for SAP Business One 10.0, version for SAP HANA, for automatic failover.

Note
Due to unpredictable factors, SAP has reservations about using this solution as part of your disaster
recovery plan. For general guidance on disaster recovery, please contact SAP Support.
The images and data in this guide are from SAP internal systems, sample data, or demo systems. Any
resemblance to real data is purely coincidental.
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Landscape

The following figure illustrates the landscape of the high availability environment.
All Linux-based SAP Business One server components are installed on the central server.
We assume the SAP HANA instance on Host 1 as the primary system, and the instance on Host 2 as the secondary
system.

1.1 Prerequisites

Before setting up the high availability environment, you must ensure that you have met the following
prerequisites.

Database Servers and Network Requirements

 You have installed SUSE Linux Enterprise Server 15 SP2 for SAP Applications and applied the latest updates,
including the latest patch of the SAPHanaSR resource agent (0.154.0-4.11.2 or later).

 You have the password of the root user.

 Caution
You must define the same password for root on both SAP HANA servers.

All commands are executed by the root user, unless otherwise stated, and are displayed in this style:
<Command>.

 Both SAP HANA database servers have been certified for SAP HANA.
 You have configured three IP addresses: two for the SAP HANA database servers and one as a virtual IP

address. In addition, the three IP addresses have the same default gateway and are on the same subnet.
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The virtual IP address will be managed by the cluster resource manager after the high-availability setup script
ha15.sh is executed. Do not bind this IP address with any particular network card.

 Both SAP HANA database servers connect to the same switch.
 For hostnames:

o The hostname of each database server must be in lower case. If you have already defined the hostname in
upper case, follow the instructions in SAP Note 1780950 to change the hostname to lower case.

o Each database server can resolve the hostname of the other server. To ensure this, on each database
server, add the mapping of the hostname and IP address of the other server to the /etc/hosts/ file.

 Both database servers connect to a shared storage server of one block through an internal storage area
network. The block device is used as an SBD (storage-based death) device and needs to meet the following
requirements:
o No partition exists on the block.
o Its size is no less than 10 M.

To check if the SBD device meets the requirements, execute this command: fdisk -l

For more information about SBD and STONITH, see http://clusterlabs.org/doc/crm_fencing.html and
http://www.linux-ha.org/wiki/SBD_Fencing.
To configure an SBD device, proceed as follows:
1. Configure the central server as an iSCSI Target Server:

Before configuring the central server, make sure that you have met the following prerequisites:
o You have shared storage, or you can use the central server as the shared storage server.
o You must dedicate one small partition as the SBD device.
o The shared storage server should not be virtualized by Hyper-V.
o The SBD device must not make use of host-based RAID.
o The SBD device must not reside on a DRBD instance.
o The SBD device can be shared between different clusters, as long as no more than 255 nodes share

the device.
Then follow the below steps to configure the central server as iSCSI Target Server:
1. Log on to the central server as ISCSI Target Server. Execute command fdisk -l to list the SBD

device which you prepared before. Here we use:
/dev/mapper/hanavg-sbd_test_1
You can copy the device path to be used later.

http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/1780950
http://clusterlabs.org/doc/crm_fencing.html
http://www.linux-ha.org/wiki/SBD_Fencing
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2. Input yast2.
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3. Go to Network Service/iSCSI Target.

4. On the Targets tab, choose Add to add a new target.
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5. On the Identifier tab, enter the iSCSI target name you want and choose Add.
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6. On the Path tab, input the devices which you copied before with command fdisk -l. Then choose
OK to add the LUN.
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7. Keep the default setting and choose Next.

8. Choose Finish to complete the configuration.
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2. Configure the iSCSI initiator on SAP HANA high availability servers.
1. Input yast2.

2. Go to Network Service/iSCSI Target.

3. On the Discovered Targets tab, choose Discovery.
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4. Input the iSCSI Target Server IP address and choose Next.

5. Choose Connect to connect to the server.
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6. On the Startup tab, choose automatic and then Next.

7. The value for the Connected tab changes to True. Choose OK to complete.
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8. Execute the command fdisk -l to check iSCSI devices status on the SAP HANA servers. You
should get 1 additional device as listed below:
dev/sdb

Time Synchronization

It is important to keep both database servers synchronized in time. We highly recommend that you use an
additional NTP server to synchronize the time on the database servers; if you do not have an NTP server, you
must be sure to check regularly that the time is synchronized.

Note
You can use the central server (for SAP Business One server components) as the NTP server.

If you use an NTP server, ensure the following points:
 Both database servers can ping the NTP server.
 On both database servers, do the following:

1. Update the NTP server IP address in Yast:

2. Choose to start NTP Daemon Now and on Boot, then add one or more NTP servers and test them.
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Supported Versions

This high availability solution is supported for SAP Business One 9.1 PL06 and higher, version for SAP HANA and
for new customers only. We require that you be familiar with the installation and upgrade processes of SAP
Business One, version for SAP HANA. Additional instructions for this high-availability solution are given below in
Installing SAP Business One, version for SAP HANA.

Others

 To ensure the system administrator can receive automatic notification via email if an SAP HANA failover
happens, ensure that you have done the following:
o Configured the mail settings on both servers to ensure the servers can send email.
o Created a distribution list or a group mail account for relevant system administrators.

 You have uploaded the following files (shipped with this guide) to Host 1:
o ha.conf

o ha15.sh

1.2 Related Documentation

For more information, refer to the following documentation:
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Documentation Remarks

SAP HANA Administrator's Guide Available at http://help.sap.com/hana_platform

SUSE Linux Enterprise High Availability
Extension HA guide

Available at https://www.suse.com/documentation

SAP Business One Administrator's
Guide, version for SAP HANA

Available in the SAP Business One product packages:
\Documentation\SystemSetup\B1_for_SAP_HANA_Admin_Guide

.pdf

Important SAP Notes

2144869 Central SAP Note for this high availability solution.

2154175 An issue with SBO Mailer on 9.1 PL06; a workaround provided.

2601083 How to modify the hostnames/IP addresses of the SAP HANA servers
after configuring the high availability cluster.

http://help.sap.com/hana_platform
https://www.suse.com/documentation
https://service.sap.com/sap/support/notes/2144869
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2154175
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2154175
http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/2601083
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2 Setup

2.1 Installation

To set up the high-availability environment, you must install some additional software other than SAP HANA. After
that, you can execute a script to set up system replication between both SAP HANA database servers and
configure the cluster resources.

2.1.1 Installing Software in the SAP HANA Box

Before executing the high-availability setup script, ensure that you have installed the following software on both
database servers:
1. SAP HANA components:

o SAP HANA database 2.0 SPS 04 or higher

 Caution
Both SAP HANA instances must have the same system ID and instance number. In addition, you must
define the same password for <sid>adm and SYSTEM for both SAP HANA instances.

o SAP HANA AFL
o 64-bit SAP HANA database client for Linux

For more information, see the SAP HANA Server Installation and Update Guide at
http://help.sap.com/hana_platform.

 Note
o You must apply for an SAP HANA license according to the contract for Host 1 (primary system). After

system replication is set up between the two database servers, the primary system replicates all
relevant license information to the secondary system.

o If you are using SAP HANA 2 Revision 059.04, find the file
python_support_fixes_hana_2.00.059.04.tar.gz that is shipped with this guide and extract
it to the Python support directory.
Run the command below as a root user:
tar -xzvf /path/to/the/archive/python_support_fixes_hana_059.04.tar.gz -C
/usr/sap/<SID>/SYS/exe/hdb/python_support/ && chown -R <sid>adm:sapsys
/usr/sap/<SID>/SYS/exe/hdb/python_support/

2. SAP host agent
After installing the above SAP HANA components, install the SAP host agent, as follows:

1. Navigate to the following folder: /usr/sap/<SID>/SYS/global/hdb/saphostagent_setup.
2. Install the SAP host agent by executing the following command: ./saphostexec -install

http://help.sap.com/hana_platform
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The agent is installed to /usr/sap/hostctrl.
3. SUSE Linux Enterprise High Availability Extension package

To install the package, do one of the following:
o Execute the following command: zypper in -t pattern ha_sles sap-hana
o Install the package from YaST, as follows:

1. Open the YaST control center.
2. Choose Software Management.

3. From the View dropdown list, choose Patterns.
4. On the Patterns tab, in the left pane, select SAP HANA Server Base and High Availability.
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5. Choose Accept.
4. SAP SAPHanaSR resource agent
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To install the agent, execute the following command (make sure you have registered first):
zypper install SAPHana

To install the agent manually with the download, execute the following command:
zypper install SAPHanaSR-0.xxx-xx.noarch.rpm

5. saptune

Use saptune to optimize SAP HANA performance:
zypper in saptune

saptune solution apply HANA

saptune daemon start

saptune solution enabled

2.1.2 Executing the High-Availability Setup Script

To set up the high-availability environment, on Host 1, execute the ha15.sh script in one of the following ways:
 [Recommended] Read the required parameters from a configuration file, as below:

1. Update the information in the configuration file ha.conf to the actual values of your system.

 Note
If you create or modify the configuration file on Windows, you must convert all line breaks (end of line,
EOL) to the Unix/Linux format. To do so, use either of the following methods:
o Before transferring the file from Windows to Linux, convert the line breaks to the Unix/Linux format.

For example, in Notepad++®, from the menu bar, choose Edit →EOL Conversion → UNIX/OSX
Format.

o On Linux, in the folder where you store the shell file, run the command dos2unix <Shell File
Name>.

2. Place ha.conf in the same folder as ha15.sh.
3. In the folder where the file ha15.sh is located, run sh ha15.sh -f.

 Read the required parameters directly with the following command line:
sh ha15.sh <Option 1> <Parameter 1> <Option 2> <Parameter 2>… …

To find out which parameters are required and can be used, check the default configuration file ha.conf or
execute sh ha15.sh -h.

The setup script asks you to review and confirm the configuration parameters before making the configuration; a
progress bar is displayed during the configuration.
After the configuration, please back up all the tenant database(s) manually to ensure that the high availability
cluster can work properly.
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Results

 A log file SBO_HANA_configure_<datetime>.log is generated in the /tmp folder.
 Apart from other resources, the SAP HANA database is added as a resource to the cluster.
 If the primary system is not available, an automatic failover is performed.

2.1.3 Installing SAP Business One, version for SAP HANA

The installation inside a high availability environment has some slight yet crucial differences from a regular
installation, as described in the procedure below.

 Note
This high availability solution is supported for SAP Business One 9.1 PL06 and higher, version for SAP
HANA and for new customers only. Existing customers are not supported until further notice.



Setting Up SAP HANA Database High Availability for SAP Business One 10.0 for Automatic Failover
Setup

 PUBLIC
© 2023 SAP SE or an SAP affiliate company. All rights reserved. 25

Prerequisite

 System replication has been set up between both SAP HANA database servers. The currently primary SAP
HANA server is Host 1.
To check the replication status, follow the instructions in SAP HANA Replication Status Check.

 You have installed the nfs-kernel-server on the central server.
To install the nfs-kernel-server, execute the following command:
zypper install nfs-kernel-server

systemctl enable nfsserver.service

systemctl start nfsserver.service

Procedure

Install SAP Business One Server Components, version for SAP HANA, on Central Server

1. On the central server, use the installation package (for example, release 9.2 PL03) to install all the SAP
Business One server components except the Backup Service.
In this step, use the virtual IP address to connect to the SAP HANA instance.

2. Install the Backup Service.
In this step, edit the SAP HANA database servers for backup, use the Host 1 IP address in the Network
Address field, and DO NOT use the virtual IP address.

Post-Installation Actions

1. In the System Landscape Directory, on the Services tab, modify the backup service:
1. Add a new SAP HANA server instance; the service name should be the virtual IP address.
2. Delete the old SAP HANA service instance of which the service name is the Host 1 IP address.

2. In the System Landscape Directory, go to the DB Instances section on the DB Instances and Companies tab,
and delete the database server.
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Edit the backup path if it displays as None.
3. Mount the backup directories on Host 2:

1. On the central server, modify the file /etc/exports as follows:
/hana/shared/backup_service/backups <host 1 IP
address>(rw,no_root_squash,sync,no_subtree_check) <host 2 IP

address>(rw,no_root_squash,sync,no_subtree_check)

/tmp/backup_service <host 1 IP address>
(rw,no_root_squash,sync,no_subtree_check) <host 2 IP

address>(rw,no_root_squash,sync,no_subtree_check)

 Note
You can provide simultaneous access to a range of machines by specifying a network and a netmask. For
example, if you want to allow access to all the machines with IP addresses between 192.168.0.0 and
192.168.0.255, you can modify the file /etc/exports as follows:
/hana/shared/backup_service/backups 192.168.0.0/255.255.255.0
(rw,no_root_squash,sync,no_subtree_check)

/tmp/backup_service 192.168.0.0/255.255.255.0
(rw,no_root_squash,sync,no_subtree_check)

For more information about setting up an NFS server, go to the following website:
http://nfs.sourceforge.net/nfs-howto/ar01s03.html.

2. Restart nfsserver:
systemctl start nfs

3. Mount the directories on Host 2:
mount <central server IP>:/hana/shared/backup_service/backups

/hana/shared/backup_service/backups

mount <central server IP>:/tmp/backup_service /tmp/backup_service

2.2 Upgrade

This chapter shows you how to upgrade your high availability environment.

2.2.1 Upgrading SAP HANA on Host 1 and Host 2

Prerequisites

If you have referred to version 3.0.0 or 3.0.1 of this guide and used the ha15.sh file delivered with the guide, please
do the following beforehand:
1. In the SAP HANA studio, double-click the relevant SAP HANA system to access the SAP HANA administrative

settings.
2. Modify the SAP HANA parameter for the SYSTEMDB database:

global.ini/[system_replication]/ logshipping_max_retention_size = 10240

http://nfs.sourceforge.net/nfs-howto/ar01s03.html
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Procedure
1. Use crm status -AD  to display the primary and secondary hosts.
2. Enable the maintenance mode as described in section 4.1.
3. Update the SAP HANA components, first on the secondary host, and then the primary host, in the following

order:
SAP HANA database and SAP HANA AFLs
64-bit SAP HANA database client for Linux

 Caution
During the upgrade, the SLD may be out of service for some time.

4. Disable the maintenance mode as described in section 4.1.

2.2.2 Upgrading SAP Business One Server Components,
version for SAP HANA, on Central Server

To upgrade the SAP Business One 10.0, version for SAP HANA components on the central server to a higher
version, perform the normal upgrade procedures. For more information, see SAP Business One Administrator's
Guide, version for SAP HANA.

 Note
If you want to upgrade SAP Business One, version for SAP HANA from 9.3 to 10.0, you need to first
uninstall the SAP Business One components on Host 1 and Host 2, and then upgrade all the SAP Business
One server components on the central server.
However, before uninstallation, you must first stop running the resource monitor in the cluster resource
manager following below steps (on any one of the HANA hosts with root user):

1. Execute below command to stop b1 resource monitor:
crm resource stop b1

After several minutes, check the status of b1 resource with the command crm status.
The status you get should be Stop.

2. Remove the b1 monitor with the command below:
crm configure delete b1
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3 Actions After Failover

3.1 Normal Failover

If the primary system becomes unavailable and fails over to the secondary system, the system administrator will
receive a notification e-mail according to the configuration. After recovering the previously primary server, the
administrator must perform the following tasks to restore the cluster.

 Note
For more information about troubleshooting, refer to "Part IV. Troubleshooting and Reference", SUSE
Linux Enterprise High Availability Extension guide at https://www.suse.com/documentation.

1. On either Host 1 or Host 2, execute the command crm cluster status  to check the status of the
cluster:

 If the status is Stopped, check the status of the SBD device by running sbd -d <Device Path> list and
do the following:
o If the status is exit or clear, execute the command crm cluster start  to restart the service.
o If the status is reset, proceed as follows:

1. Run the following commands to clear the reset status.
sbd -d <Device Path> message <Server Name> clear

2. Restart the crm cluster:
crm cluster start

 Example
There is one SBD device (/dev/sdb). The command is sbd -d
/dev/sdb list and the result is as follows:

0 host1 reset host2

1 host2 clear

To clear the reset status of the SBD device on Host 1, execute the following command:
sbd -d /dev/sdb message host1 clear

 If the result is Running, execute this command to ensure all resources are indeed available: crm status  -
AD.

The output should be similar to the following:

http://www.suse.com/documentation
http://www.suse.com/documentation
http://www.suse.com/documentation
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2. Ensure the recovered (previously primary) SAP HANA on Host 1 is registered as secondary on Host 2
(currently primary), as follows:

1. On Host 1, switch to the <sid>adm user.
2. Check the SAP HANA status: hdbnsutil -sr_state and then do either of the following:

o If the output is as below, it means Host 1 is still (erroneously) registered as the primary system.
mode: primary site id: 1

site name: host1

Stop the system and then register it as the secondary system on Host 2:
HDB stop

hdbnsutil -sr_register --name=<host 1 hostname> --remoteHost=<host 2
hostname> --remoteInstance=<Instance Number> --replicationMode=syncmem

o If the output is as below, it means Host 1 has already been registered as the secondary system and
you can proceed to the next step.
mode: syncmem

site id: 2

site name: host1

active primary site: 1

3. Start the system: HDB start

 Caution
If you encounter any error during the registration or system startup, contact SAP Support.

3. After several minutes, check the SAP HANA replication status (Host 1 as the secondary system):
crm_attribute -N host1 -G -n hana_ndb_sync_state -l reboot -q, or check the value of
hana_ndb_sync_state with the command line crm status -AD.
You may get one of the following results:
SFAIL: System replication is still in process. You may wait for a few more minutes and check again.
SOK: System replication is complete.

3.2 Failover Due to Disk Space Availability

To prevent a primary server from running out of disk space, and thus being unable to provide database service,
the primary SAP HANA will automatically fail over to the secondary node when the primary server has less than
8GB of free space.
When the failover happens, you will be notified by email. Please do the following on the previously primary server
to recover the cluster:
1. Free up the partition where /hana/data and /hana/log are located, and the / root directory space.
2. Restart the crm cluster on the former primary server:

crm cluster stop
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crm cluster start

3. Register the former primary SAP HANA database as secondary on the currently primary node.
4. Start the former primary SAP HANA database manually: HDB start.
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4 Daily Maintenance

System administrators should perform the following tasks on the high availability cluster as part of their daily
maintenance work.

4.1 Manual Tasks Without Failover

If you plan to do some manual maintenance tasks, for example, restart the OS, patch the OS, or restart the SAP
HANA instance without unexpected behaviors or failover, please enable the maintenance mode:
crm maintenance on

All the resources will be defined as unmanaged. Check the crm status as below:
crm status

After you finish your tasks, please disable the maintenance mode:
crm maintenance off

4.2 Tenant Database Backup

The newly created tenant databases on the primary server must be backed up first, so that they can be replicated
to the secondary SAP HANA instance. Otherwise, the replication status will be SFAIL, and the failover to the
secondary node will be suspended when the primary node is down.
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4.3 Status Check on Cluster

1. Log in to Host 1.
2. Execute the command crm cluster status. The status should be active/Running.

If the status is Stopped, execute crm cluster start to bring the node online:
3. Repeat the above steps on Host 2.

4.4 Status Check on Resources

On either Host 1 or Host 2, execute the command crm_mon -r to check the status of the cluster resources
dynamically. The result should be similar to the following:

4.5 Status Check on SAP HANA Replication Function

To check the status of replication between the primary and secondary systems, in the SAP HANA studio, in
SYSTEMDB, in the administration view of Host 1, on the Landscape tab, on the System Replication sub-tab, check
the REPLICATION_STATUS column. The screenshot below demonstrates the normal status of the system
replication:



34
PUBLIC
© 2023 SAP SE or an SAP affiliate company. All rights reserved.

Setting Up SAP HANA Database High Availability for SAP Business One 10.0 for Automatic Failover
Daily Maintenance

4.6 Maintenance of Operating SBD Devices in a Live
Environment

If you want to perform maintenance on operating SBD devices without unexpected behaviors or failover, for
example, replace, restart, or patch the iSCSI Target Server, or move it to another endpoint, please follow the steps
below:

1. Enable the maintenance mode on either one of the two servers:
crm maintenance on

2. Disable and stop the cluster on both servers:
crm cluster disable

crm cluster stop

3. Change the iSCSI Target Server as described in 1.1 Prerequisites.
4. Create new SBD devices on either one of the two servers:

sbd -d /dev/sdb create

5. Check if the UUIDs on both servers are identical:
sdb -d /dev/sdb dump

6. start and enable the cluster on both servers:
crm cluster start

crm cluster enable

7. Disable the maintenance mode on either one of the two servers:
crm maintenance off

4.7 Requesting Technical Support

If you need technical support from SAP, please run the command crm report, and then find and upload the file
hb_report-<Timestamp>.tar.bz2 to your support ticket.
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